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General Description
The MAX11300 evaluation kit (EV kit) provides a proven 
design to evaluate the MAX11300 20-port program-
mable mixed-signal I/O with 12-bit ADC, 12-bit DAC, 
analog switches, and GPIO. The EV kit also includes 
Windows XP®-, Windows Vista®-, Windows® 7-, and 
Windows 8.0-/8.1-compatible software that provides a 
simple graphical user interface (GUI) for exercising the 
features of the IC.
The EV kit comes with a MAX11300GTL+ installed.

Features and Benefits
●● 20 PIXITM Ports for Analog or Digital Control or 

Sensing
●● Two External Temperature Sensors (2N3904)
●● 50-Pin Signal Header (20 Ports, Two Temperatures, 

and Power Supplies)
●● SPI Interface Terminals
●● Optional 2.5V On-Board Reference (MAX6071)
●● Windows XP-, Windows Vista-, Windows 7-, and 

Windows 8.0-/8.1-Compatible Software
●● USB-PC Connection (Cable Included)
●● RoHS Compliant
●● Proven Four-Layer PCB Layout
●● Fully Assembled and Tested 

19-7415; Rev 0; 5/14

Ordering Information appears at end of data sheet.

Windows, Windows XP, and Windows Vista are registered  
trademarks and registered service marks of Microsoft 
Corporation.
PIXI is a trademark of Maxim Integrated Products, Inc.

Note: Active-low pin names such as INT are shown in the  
software and PCB layout with a B suffix (e.g., INTB).

Quick Start
Required Equipment

●● EV kit (USB mini-B cable included)
●● Windows XP, Windows Vista, Windows 7, Windows 

8.0, or Windows 8.1 PC, running .NET v4, with a 
spare USB port

●● ±12.5V DC at 500mA dual-output DC power supply
●● Digital voltmeter (DVM)

Note: In the following sections, software-related items are 
identified by bolding. Text in bold refers to items directly 
from the EV kit software. Text in bold and underlined 
refers to items from the Windows operating system.

Procedure
The EV kit is fully assembled and tested. Follow the steps 
below to verify board operation:

1)	 Visit www.maximintegrated.com/evkitsoftware to 
download the latest version of the EV kit software, 
MAX11300EVKitSetupV1.0.zip. Save the EV kit soft-
ware to a temporary folder and uncompress the ZIP 
file.

2)	 Install the EV kit software and USB driver on your com-
puter by running the MAX11300EVKitSetupV1.0.exe 
program inside the temporary folder. The program 
files are copied to your PC and icons are created in 
the Windows Start | Programs menu. During soft-
ware installation, some versions of Windows may 
show a warning message indicating that this software 
is from an unknown publisher. This is not an error 
condition and it is safe to proceed with installation. 
Administrator privileges are required to install the 
USB device driver on Windows. Note: The software 
requires .NET Framework v4. If this framework is not 
detected during installation, the installer launches 
dotNetFx40_Full_setup.exe to install it. Internet ac-
cess may be required to install the .NET Framework 
v4 if it is not already installed.

3)	 Verify that all jumpers are in their default positions, as 
shown in Table 1, Table 2, Table 3, and Table 4.

4)	 Configure the power supply for ±12.5V DC output 
(typical load current is 50mA) (be sure to keep AVD-
DIO-AVSSIO within rated supply range).

http://www.maximintegrated.com/evkitsoftware
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5)	 Connect the +12.5V DC power supply between  
AVDDIO (+) and GND (-). Connect the -12.5V DC 
power supply between AVSSIO (-) and GND (+).

6)	 Connect the DVM- to GND (-)
7)	 Enable the power-supply output.
8)	 Connect the USB cable from the PC to the EV kit 

board. A Windows message appears when connect-
ing the EV kit board to the PC for the first time. Each 
version of Windows has a slightly different message. 
If you see a Windows message stating Ready to 
Use, proceed to the next step. Otherwise, open the  
USB_Driver_Help_200.PDF document in the Win-
dows Start | Programs menu to verify that the USB 
driver was installed successfully.

9)	 Use the DVM+ to verify the test point voltages shown 
in Table 2.

10)	 Start the MAX11300 Configuration Software by open-
ing its icon in the Windows Start | Programs menu. 

The MAX11300 configuration software main window 
appears, as shown in Figure 1. Drag and drop com-
ponents into the device, wire them up, and then use 
the File menu | Generate Registers to export the  
configuration to Max11300Register.csv.

11)	 Start the EV kit software by opening its icon in the 
Windows Start | Programs menu. The EV kit soft-
ware main window appears, as shown in Figure 2.

12)	 Select File menu | Load Configuration... | 
MAX11300Register.csv to load the configuration 
into the MAX11300. Alternatively, use one of the  
prebuilt demo configurations, such as MAX11300Reg-
ister_20131115_1505.csv, which configures all 20 
PIXI ports with different configurations.

13)	 Select the Chart tab, then check Options menu | 
Polling to show the analog inputs on a graph. Select 
the Data tab to see the low-level input code values in 
hexadecimal.

Figure 1. MAX11300 EV Kit Configuration Software

Figure 1
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Detailed Description of EV Kit Software
The Device Configuration tab (Figure 2) accesses 
the global device control registers, interrupt sources, 

temperature limits, DAC presets, and ADC conver-
sion rate. Changing the controls on the GUI writes the  
corresponding registers immediately.

Figure 2. Device Configuration Tab

Figure 2
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Figure 3. Data Tab

Figure 3
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The Data tab (Figure 3) presents a tabular display of 
all PIXI ports and temperature channels. Double-click 
in the Configured As cells to jump directly to the Pin 
Configuration tab (Figure 5) for the corresponding pin. 
Each row represents one of the PIXI ports or one of the 
temperature sensors. Some configurations enable DAC 

Out or GPO Out controls, or provide ADC or GPI input 
values. Pins configured for GPI input can be used as 
interrupt sources by double-clicking in the Interrupt cell.
Select the Chart tab (Figure 4), then check Options 
menu | Polling to show the analog inputs on a graph.

Figure 4 Chart Tab

Figure 4
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The PIXI ports can be viewed and manually adjusted from 
the Pin Configuration tab. Selecting the pin function 
affects the choices in the other four fields. The software 
does not attempt to validate the configuration.
The normal development flow is to start in the MAX11300 
Configuration software, use its Generate Registers 
menu item to export the registers to a *.csv file, then use 
the EV kit software to connect to the hardware and load 
that *.csv file.

The GPIO1–GPIO3 pins are spare outputs from the 
MAXQ2000 microcontroller that can be optionally used to 
support external diagnostic testing. They are not part of 
the MAX11300.
The supply voltages are used to help validate the avail-
able operating ranges, but the software has no way to 
independently verify that the nominal values are actually 
present.

Figure 5. Pin Configuration Tab

Figure 5
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The Registers tab (Figure 6) provides a tabular display of 
all registers of the device, supporting low-level read and 
write operations in hexadecimal. Write is effective by the 

Write button. Refer to the MAX11300 IC data sheet for 
the meaning and format of the various registers.
The History tab provides a diagnostic log of the  
commands sent to the EV kit.

Figure 6. Registers Tab

Figure 6
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Detailed Description of Hardware
The MAX11300 EV kit uses an on-board MAXQ2000 
microcontroller (U120) to send SPI commands to the 
device. On-board level translators (U101, U102, and 
U105) convert from 3.3V to 5V levels. On-board MAX6071 
voltage references (U3, U6) provide ADC and DAC  
reference voltages. Remote temperature sensing can be 
simulated by on-board 3904 npn transistors (D0, D1). See 
Figure 7.

Connecting to User-Supplied Circuitry
The EV kit connects to external, user-supplied circuitry 
through header J1 or J2. These two headers have the 
same signals; J1 is for vertical 50-pin ribbon-cable con-
nection and J2 is for right-angle connection to a sideboard 
by standard 0.100in right-angle pins.
If remote temperature sensing is used, disconnect on-
board npn transistors D0 and D1 by moving the shunts of 
JUD0P, JUD0N, JUD1P, and J1D1N to the 1-4 position.

Figure 7. MAX11300 EV Kit Hardware Overview

Figure 7
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Table 1. Jumper Configuration (Power Supply)

JUMPER SIGNAL SHUNT 
POSITION DESCRIPTION

JU_AVSSIO_GND AVSSIO
No Shunt* AVSSIO must be supplied by user negative power supply

1-2 AVSSIO = GND 

JU_DVDD DVDD

1-2* DVDD is supplied from MAX1659 +5V LDO powered from AVDDIO

2-3 DVDD is supplied from USB

No Shunt DVDD must be supplied by user power supply

JU_AVDD AVDD

1-2* AVDD is supplied from DVDD directly

2-3 AVDD is supplied from DVDD, filtered by RAVDD and CAVDD

No Shunt AVDD must be supplied by user power supply
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Table 1. Jumper Configuration (Power Supply) (continued)

Table 2. Jumper Configuration (Digital Interface)

*Default position.
**Default connection by a trace on the PCB; jumper pins not installed; shunt not included.

*Default position.
**Default connection by a trace on the PCB; jumper pins not installed; shunt not included.

JUMPER SIGNAL SHUNT 
POSITION DESCRIPTION

JU_SDA_DIN SDA_DIN

1-2** SDA_DIN = MAXQ_MOSI (SPI interface mode)

2-3 SDA_DIN = MAXQ_SDA (reserved)

No Shunt SDA_DIN = User-supplied connection

JU_SDA SDA
1-2 SDA pullup to DVDD by R103 (reserved)

No Shunt* R103 is not connected (SPI interface mode)

JU_SCL_SCLK SCL_SCLK

1-2** SCL_SCLK = MAXQ_SCLK (SPI interface mode)

2-3 SCL_SCLK = MAXQ_SCL (reserved)

No Shunt SCL_SCLK = User-supplied connection

JU_SCL SCL
1-2 SCL pullup to DVDD by R104 (reserved)

No Shunt* R104 is not connected (SPI interface mode)

JU_AD0_CSB AD0/CSB

1-2** AD0/CSB = MAXQ_CS (SPI interface mode)

3-4 AD0/CSB = DVDD (reserved)

5-6 AD0/CSB = SCL_SCLK (reserved)

7-8 AD0/CSB = SDA_DIN (reserved)

9-10 AD0/CSB = DGND. (reserved)

JU_AD1_DOUT AD1/DOUT

1-2 AD1/DOUT = DGND (reserved)

1-3** AD1/DOUT = MAXQ_MOSI.(SPI interface mode)

1-4 AD1/DOUT = DVDD (reserved)

JU_INTB INTB
1-2** INTB = MAXQ_K5 interrupt input to microcontroller

Open INTB = user-supplied connection

JU_CNVTB CNVTB
1-2** CNVTB = MAXQ_K4 output from microcontroller

Open CNVTB = user-supplied connection

JUMPER SIGNAL SHUNT 
POSITION DESCRIPTION

JU_U1_AVDDIO AVDDIO 1-2** Measure the supply current by putting a current meter in series with 
the jumper.

JU_U1_AVSSIO AVSSIO 1-2** Measure the supply current by putting a current meter in series with 
the jumper.

JU_U1_AVDD AVDD 1-2** Measure the supply current by putting a current meter in series with 
the jumper.

JU_U1_DVDD DVDD 1-2** Measure the supply current by putting a current meter in series with 
the jumper.
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Table 3. MAX11300EVKIT Jumper Configuration (Temperature Sensor)

Table 4. MAX11300EVKIT Jumper Configuration (On-Board External References)

*Default position.

*Default position.

JUMPER SIGNAL SHUNT 
POSITION DESCRIPTION

JUD0P D0P

1-2 10Ω resistor RD0P emulates long connection wire series resistance, using 
on-board MMBT3904 as temp sensor

1-3* Direct connection to on-board MMBT3904 used as temp sensor

1-4 Connect external temperature sense diode junction to D0P_ext / D0N_ext 
pair on header J1, J2, or J3

JUD0N D0N

1-2 10Ω resistor RD0N emulates long connection wire series resistance, 
using on-board MMBT3904 as temp sensor

1-3* Direct connection to on-board MMBT3904 used as temp sensor

1-4 Connect external temperature sense diode junction to D0P_ext / D0N_ext 
pair on header J1, J2, or J3

JUD1P D1P

1-2 10Ω resistor RD1P emulates long connection wire series resistance, using 
on-board MMBT3904 as temp sensor

1-3* Direct connection to on-board MMBT3904 used as temp sensor

1-4 Connect external temperature sense diode junction to D1P_ext / D1N_ext 
pair on header J1, J2, or J3

JUD1N D1N

1-2 10Ω resistor RD1N emulates long connection wire series resistance, 
using on-board MMBT3904 as temp sensor

1-3* Direct connection to on-board MMBT3904 used as temp sensor

1-4 Connect external temperature sense diode junction to D1P_ext / D1N_ext 
pair on header J1, J2, or J3

JUMPER SIGNAL SHUNT 
POSITION DESCRIPTION

JU_ADC_REF ADC_EXT_REF
1-2* On-board MAX6071 reference U2 drives ADC_EXT_REF

Open On-board MAX6071 reference U2 is disconnected from ADC_EXT_REF

JU_DAC_REF DAC_REF
1-2* On-board MAX6071 reference U3 drives DAC_REF  

(Kelvin connection force)

Open On-board MAX6071 reference U3 is disconnected from DAC_REF

JU_DAC_REFS DAC_REFS
1-2* On-board MAX6071 reference U3 drives DAC_REF  

(Kelvin connection sense)

Open On-board MAX6071 reference U3 is disconnected from DAC_REF
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Table 5. MAX11300EVKIT Jumper Configuration (Microcontroller)

Table 6. Microcontroller Resources

Table 7. Test Point Voltages

*Default position.

JUMPER SIGNAL SHUNT 
POSITION DESCRIPTION

JU_LED1 MAXQ_K1
1-2* MAXQ2000 port 0.0 (MINIQUSB firmware signal K1) drives diagnostic indicator LED1

Open MAXQ2000 port 0.0 (MINIQUSB firmware signal K1) is disconnected from LED1

JU_LED2 MAXQ_K2
1-2* MAXQ2000 port 0.1 (MINIQUSB firmware signal K2) drives diagnostic indicator LED2

Open MAXQ2000 port 0.1 (MINIQUSB firmware signal K2) is disconnected from LED2

JU_LED3 MAXQ_K3
1-2* MAXQ2000 port 0.2 (MINIQUSB firmware signal K3) drives diagnostic indicator LED3

Open MAXQ2000 port 0.2 (MINIQUSB firmware signal K3) is disconnected from LED3

GPIO SIGNAL DIRECTION JUMPER DESCRIPTION

MAXQ_K1 Output from MAXQ2000 JU_LED1 Diagnostic indicator LED1

MAXQ_K2 Output from MAXQ2000 JU_LED2 Diagnostic indicator LED2

MAXQ_K3 Output from MAXQ2000 JU_LED3 Diagnostic indicator LED3

MAXQ_K4 Output from MAXQ2000 JU_CNVTB Convert-Start signal to MAX11300 CVNBT input

MAXQ_K5 Interrupt input to MAXQ2000 JU_INTB Active-low Interrupt from MAX11300 INTB output;
can also be triggered by momentary pushbutton INT0.

MAXQ_K6 Interrupt input to MAXQ2000 — Active-low Interrupt from momentary pushbutton INT1

MAXQ_K7 Interrupt input to MAXQ2000 — Active-low Interrupt from momentary pushbutton INT2

MAXQ_K8 Interrupt input to MAXQ2000 — Active-low Interrupt from momentary pushbutton INT3

TEST POINT
VOLTAGE (V)

NOMINAL MINIMUM MAXIMUM

+3.3V TP142 from U2 MAX8511 3.3 3.267 3.333

+2.5V TP132 from U7 MAX8511 2.5 2.475 2.52

+5V from U8 MAX1659 5.0 4.85 5.15

DVDD from U8 MAX1659 5.0 4.85 5.15

ADC_INT_REF from U1 MAX11300 2.5 2.494 2.506

ADC_EXT_REF from U6 MAX6071 2.5 2.4 2.6

DAC_REF from U3 MAX6071 2.5 2.4 2.6
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Figure 8a. MAX11300 EV Kit Schematic (Sheet 1 of 5)

Figure 08a
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Figure 8b. MAX11300 EV Kit Schematic (Sheet 2 of 5)

Figure 08b
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Figure 8c. MAX11300 EV Kit Schematic (Sheet 3 of 5)

Figure 08c
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Figure 8d. MAX11300 EV Kit Schematic (Sheet 4 of 5)

Figure 08d
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Figure 8e. MAX11300 EV Kit Schematic (Sheet 5 of 5)

Figure 08f
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Figure 9. MAX11300 EV Kit Component Placement Guide—Component Side

Figure 9
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Figure 10. MAX11300 EV Kit Component Placement Guide—Solder Side

Figure 10
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Figure 11. MAX11300 EV Kit PCB Layout—Component Side

Figure 11
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Figure 12. MAX11300 EV Kit PCB Layout—Ground Layer 2

Figure 12
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Figure 13. MAX11300 EV Kit PCB Layout—Power Layer 3

Figure 13
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Figure 14. MAX11300 EV Kit PCB Layout—Solder Side

Figure 14
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#Denotes RoHS compliant.

PART TYPE

MAX11300EVKIT# EV Kit

Ordering InformationComponent List
Refer to file “evkit_bom_max11300_evkit_a.csv” attached 
to this PDF for component information.
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